


A Note from Deputy Commissioner, KVS Delhi Region 

It is an established fact that the computer education in school plays an 
important role in overall development of students. Computer with an 
internet access is the most powerful weapon, which opens the doorway of 
all information, knowledge and skill available in this universe. However, 
there was a definite syllabus but in the absence of any study material 
transaction of the computer literacy as a subject was limited to the 
imagination of the teacher. 

With the advent of new era of artificial intelligence, it is need of the time to 
introduce technology and coding at an early stage to students, in a 
uniformed and standard way. In our endeavour to help students become 
better equipped and confident, we have taken the initiative to develop 
syllabi and textbooks which touch all the paradigm of teaching ICT in well 
directed manner. 

This book series for class 3 to 8 has been developed with efforts of many 
teachers and contributions from academicians of KVS Delhi Region. It is 
based on detailed computer literacy syllabus as per CCE(RTE) and all 
applications taught are based on free and open source software. 

The lesson is based on interaction between two students from primary 
classes to encourage auto didacticism and to teach them how to think and 
improve problem solving. We have focused on content and skills to lay a 
strong foundation for learning computers. 

The accomplishment of this venture depends on the cooperation of all 
principals and teachers who will encourage children, guide them and help 
them at different steps and give them infrastructure and proper guidance 
to use this Book. 

Comments on the book and suggestions for next edition are most 
welcome and may be sent to support@kvsrodelhi.in.  

(Nagendra Goyal) 
Deputy Commissioner 
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1. Database of Students in a school. 

2. Database of Items in a Shopping Mall. 

3. Database of Patients in a Hospital. 

4. Database of Account Holders in a Bank. 

5. Database of Websites on Google. 

6. Database of Players in a Team Game 

   And many more…. 

 

 

1.3  DATABASE MANAGEMENT SYSTEM(DBMS) 

 
We have already understood the terms data and database. There are thousands of 

records of students in a school over the years which need to be stored in such a 

manner that every time someone requires some information about any particular 

student at any point of time, our database gives the accurate and desired 

details/information.  

 

Now, here comes the need for a system that is used to manage a huge amount of 

data/information in an organization over a long period of time without compromising 

with the accuracy of the data. The answer is Database Management System. 

 

 DBMS: Its full form is Database Management System and it is a software 

system which is used to create, edit, delete, search data in a database. There 

are various examples of DBMS available in software like MS-Access, Base in 

Libre Office, Oracle, MySQL, etc. 

 

 

 

 

 

 

 

 

 

 

 

 

We will work in Base DBMS software which is packaged in LibreOffice. 
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The given table will show some of the common data types used in table in Base of 

LibreOffice:- 

 
Some of the important data types are discussed here: - 

 

Data Type Type of Values that may be stored 

Text [ Varchar ] Text values like alphabets or numbers or special 

characters 

Number [ NUMERIC ] Only Numbers or Numeric values 

Integer [ INTEGER ] Only integer both positive and negative 

Decimal [ DECIMAL ] Stores decimal values 

Float [ FLOAT ] Stores decimal values 

Date [DATE] Stores date values 

 

1.6  PRIMARY KEY IN A TABLE 

 
 Primary Key: - A Primary key is that column or a field which is used to identify 

unique values in a table. It is very important to get accurate information from 

thousands of records stored in a table.  

 
Let us understand the primary key with an example. For example, we have 5 records of 

5 students in the above table of students. In the table, 2 students have the same 

name. Then how can one can identify the correct student in the table? Therefore, we 

must have such a column in the table that must identify the unique record among any 

number of records like “ADMNO” given in the above table Student. Here ADMNO can 

be said to be a primary key to identify each record differently. 
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EXERCISE 1.1 
A. Answer the following questions. 

1. What do you mean by a database? 

__________________________________________________________ 

2. What is a DBMS and why is it required? 

__________________________________________________________ 

3. What is a table in a database? 

__________________________________________________________ 

4. Give the name of any one real world example in which you have learnt about 

database. 

__________________________________________________________ 

5. What is a primary key? 

     __________________________________________________________ 

B. Fill in the blanks: - 

1. ______ is the storage area which is used to store a huge amount of data. 

2. DBMS stands for ___________________________________. 

3. ___________ is the intersection of many rows and columns. 

4. ___________ is a data type used to store text values. 

5. _______ is the column which is used to identify unique values in a table. 

 

C. State True / False: - 

      1. In a database, data is stored only in tables. 

      2. Database Management System is a hardware used to maintain the data of the 

database. 

      3. Primary key is a row/record used to identify unique values in a table. 

      4. Data type is used to specify the kind of data to be used in a column of a table. 

      5. A table is a collection of data in textual form. 

SOMETHING TO DO 

 1. Observe any 5 areas around your real-world surroundings and identify their name of 

databases which are being used. 

2. Create a table named Marks in MS-Excel having the following columns and store 

%age marks of any of your 5 friends :  

Name Class Percentage 
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Step-5: Now click on the “Next” button as shown in the above screenshot. Then, you 

will get the following screen in which you have to give the appropriate data types of 

every field: 

 
  

Step-6: Now click on the “Next” button as shown in the above screenshot. Then, you 

will get the following screen in which you have to select the appropriate PRIMARY KEY 

for your table by which every record may be identified uniquely: 

 
In this step, you may select the 1st option to “Automatically add a Primary Key” or you 

may select the 2nd option to “Use an existing field as a primary key”. Don’t use 3rd 

option as it is out of scope of your book. Then click on the “Next” button. We use 
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“CONTACT ID” as the primary key from our fields using the 2nd option as shown on the 

given screen. 

 
 

Step-7: Now click on the Next button. Then the following screen will be shown to us. 

 
Now click on the “Finish” button. You will see the following screen. 
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Step -3: Then select the “Table” icon and click on the “Contacts” table. Then the 

following screen will appear: 

 
 

Now enter some data in each of the columns of the above table for one contact 

“Aman”. The following screen will appear. 

 
 

Now enter as many records as per your contact list. Suppose, we enter 4 more contact 

records in it. The screen will appear as below: - 
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Now, select the “Delete Record” option from the menu and the record of ‘Kishan’ will 

get deleted. The screen after deletion will be shown as: 

 

Likewise, we may delete other records as per our need. 

So, this is how we can insert and delete records from a table in Base of Libre Office. 

Now, it’s time for you to practice on your computer system. 

1.10 QUERY CREATION USING WIZARD 
 

In this article, we will discuss how to query some information from a table. For this, we 

need to understand the meaning of the term “Query”. Let us discuss it first. 

 Query: A query is a kind of request for some information from a database or in 

general term query means to ask some information. Actually, this is the aim of 

developing a database to provide us information as required. Also, all of us 

always need some or the other kind of information in our day-to-day life. 

Therefore, we learn how to develop database and query them for getting 

information as per our requirement. Base software of Libre Office also provides 

us the facility to query the database.  

 

For example, one may need the first name of those contacts who live in “Delhi” 

from our above created table “Contacts”. 

Copyright Number:- L-100563/2021 Registered With:- KVS Delhi Region



P a g e  | 16                                                   KVS DELHI REGION 2021 
 

Let us now learn to create the query on the above example in Base of Libre Office with 

the help of our “CONTACTS” table which is created in the previous articles. 

Step -1 : Open Libre Office and select “Base Database”: 

 

 

Step -2 : Then select the “Queries” option and click on the option “Use Wizard to 

Create Query” to create queries on the “Contacts” table . 

 
 

Step -3: The following screen will appear which shows the steps to create a query 

using Wizard. Now, select the “Table” from which we have to make a query. As soon as 

we select the table, its fields will be shown just below it. Just observe the fields of 

“Contacts” table in the screenshot given below: 
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Step-4: Now, we have the option to select all columns or select those columns which 

we require in our query. As we have to display the “First Name” and the “City” of those 

contacts who have their City as “Delhi”, we need to select only the “FirstName” and the 

“City” column and click on the “Next” button as shown on the screen given below: 

 

Step-5: Now, on the next screen, we need to select one or more fields/columns which 

is/are to be sorted either in Ascending or Descending Order.  
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So, if we want to show the First name in ascending order (i.e. from alphabet a to z), we 

should do the same on the screen given below:- 

 

Step-6: Now on the next screen, we have to put some conditions of the query like we 

need the First Name of “Delhi” city. So, we will select the field “City” and give the 

value “Delhi” whose First name we need. 

 

We may also put some more condition(s) as per our requirement of information on the 

above screen. 

Step-7: Now, on the next screen, we may also give alias names or names of the 

columns we want. Let us see. 
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Step-8: Now, on the next screen, we have to give a name to our query (“First Name of 

Delhi”)  and overview our query which we have created till now: 

 

You can observe on the above screen, we have selected the “FirstName” and the “City” 

fields from the “Contacts” table, all records should be in Ascending order of 

FirstName field, City should be “Delhi”, etc. Now, select the option “Display Query” as 

shown on the above screen and click on the “Finish” button.  

 

As you are observing from the above screen that we have got the First Name of those 

contacts whose city is “Delhi”.  

We may also check whether the correct information has come in our Query or not by 

viewing all records of our table “Contacts”. Let us check it now from the screen given 

below: 
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As we can observe from the records of the “Contacts” table, our query shows the 

correct first names of all contacts who are living in city “Delhi”. 

Note: As we add more records in our Table “Contacts” our query will show those 

records which fulfil the condition of “Delhi” city automatically. This is a very good 

feature in our DBMS Base of Libre Office. 

 

Now, it’s your time to practice the above steps to create a query for better 

understanding. 

EXERCISE 1.2 

 

A. Answer the following questions. 

1. What do you mean by Wizard? 

____________________________________________________________ 

2. What is the importance of a Wizard? 

____________________________________________________________ 

3. Can we assign a primary key to a field during the creation of a table using wizard? 

____________________________________________________________ 

4. What do you mean by a query?  

______________________________________________________________ 

5. What is the use of query in a database?  

______________________________________________________________ 

B. Fill in the Blanks 

1. A __________ is a step by step help of the procedure of creation of a database 

object. 

2. A __________ is a request to fetch some information from a database. 

3. One can _________ a field either by ascending or descending order during the 

creation of a query. 

4. We can add or delete __________(s) from the table at the time of creation of a 

table using wizard. 

5. One can give _________ name to a field/column during the creation of a query using 

wizard. 
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C. State True / False:- 

1. Any number of columns may be added to the table during creation using wizard. 

2. A wizard is a step-by-step guide to create a table only. 

3. Query is a request of information from the table. 

4. A query may have few or all columns as per the need of information. 

5. A query once created cannot be deleted. 

SOMETHING TO DO 

1. Create a table named “Customers” using Wizard that will having the following fields: 

Field Name Data Type 

CustomerID Integer 

First Name Varchar 

CompanyName Varchar 

MobileNumber Integer 

Department Varchar 

Also, add any 10 records into the above table on your own. 

 

2. Create the following queries on the above table “Customers” using Wizard:- 

(a) To display the name of those customers who have “Finance” Department. (Add some 

values of “Finance” in the Department column). 

(b) To display the name and mobile number of all customers in ascending order of their 

first names. 

(c) To display all records in descending order of their Mobile Number. 

(d)To display the name of all the customers who have Mobile Number less than 

9555565555. 
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2.RECAP OF PYTHON OF CLASS VII 
 

2.1 BASICS OF PYTHON 

2.2 VARIABLE, DATATYPES AND KEYWORDS 

2.3 OPERATORS (ARITHMETIC & RELATIONAL) 

2.4 SEQUENCE BASED PROGRAMMING 

2.5 “if..else” STATEMENT 

 

2.1 BASICS OF PYTHON 
 

Dear students, you have definitely well understood the basic concepts of Python in 

class VII and must have practiced and enjoyed them a lot. Also, to solve more Real-

World Problems, one must know the topics we have discussed in this class. But to start 

with the new topics in a smooth manner, we should revise quickly the concepts of class 

VII taught earlier. 

 

 Programming is the process of writing codes (instructions) in a programming 

language to resolve some problem/ create games / develop software/ create websites 

etc. 

 

 Algorithm is the process of writing all the steps required to solve a particular 

problem. These steps are written in English language to describe each statement.  

To develop an algorithm following steps are required: 

1. Read problem definition 

2. Analyze the problem to identify Input, Output and Process 

3. Develop an algorithm  

4. Refine by adding more details 

5. Review the developed algorithm 

 

 Flowchart: Flowchart is a pictorial representation of steps involved in the solution 

of a problem. Flowchart is easier to understand as it depicts the solution graphically. 

To draw a flowchart, following symbols are used for various purposes. 

 

Start /Stop Input/Output Process Decision 

Box 

Flow lines Connector 

      

 

 Advantages of Flowchart:- 
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1. Improved Communication, 

2. Visual Clarity, 

3. Effective Analysis, 

4. Problem Solving, 

5. Documentation. 

 Python: Python is an open source, high level programming language which has simple 

syntax similar to the English language. Python was created by Guido Van Rossum in 

December 1989. The language name is not about snakes, but its name was picked from 

British Comedy Troupe Monty Python’s Flying Circus. Guido Van Rossum is a big fan of 

Monty Python’s Flying Circus.  Python is used by many big companies like NASA, Google, 

Nokia, IBM, Netflix, Facebook and Yahoo Maps etc.  

 Features of Python:- 

1. Python is Popular: Python is a popular programming language due to its 

simple syntax and wide range of applications in various fields. 

2. Python is Interpreted: Python is an interpreted programming language. 

Interpreter is that converter program which converts high level language 

to machine language, one statement at a time. 

3. Python is Free: Python is freely available to download, use, distribute and 

modify. Python is an Open-Source Programming    Language. 

4. Python is Portable: Python is a portable programming language. Portability 

refers to execution of codes on different platforms. If we develop codes 

for Windows and we want to run on another platform, we don’t need to 

change it.  

5. Python is Easy to Learn and Use: Python is not just easier to understand, 

but it is also easier to use.  

6. Python support to GUI programming: Python supports GUI programming 

with additional libraries or toolkits. 

 

2.2  VARIABLE, DATATYPES & KEYWORDS 

 
 Variable:- A variable is an identifier or a name used for a value during the 

program time. E.g., Marks=75.8. Here Marks is a variable which is used to store a 

value 75.8. 

 
 Data Type:- A data type is used to specify the type of data which may be used 

in a variable in python. For example, there may be different types of data which 

we deal with like integers, decimal values, character values, special 

characters/symbols, etc. So, in order to store a particular type of value, we 

need its data type. The given table will show some of the common data types 

used in python:- 

 

Copyright Number:- L-100563/2021 Registered With:- KVS Delhi Region



P a g e  | 24                                                   KVS DELHI REGION 2021 
 

  
Sample Value Python Data Type used 

Integer Values (1,20, 1500, etc.) Int 

Decimal Values (3.14, 1.73, etc.) float 

Character Values (a, d, D, etc.) String 

Special Characters/Symbols String 

 
 Keyword:- A Keyword is a pre-defined reserved name in a programming language 

like python which has fixed working or function. Its function cannot be changed 

at all during programming. Some of the examples are if, else, in, for, etc. 
 

2.3  OPERATORS (ATRITHMETIC & RELATIONAL) 
 

 Operator: Operators are special symbols that are used to perform operations on 

operands. The values that the operator operates on are called operands.  

 Expression: Expression is combination of operator and operands. 

 Arithmetic Operator: Arithmetic operator is used to apply basic mathematical 

operations like addition, deletion, multiplication, division, etc. These operators 

require two operands to operate. Following are some of the binary operator.    

Name of 

Operator 

Symbol 

used 

Purpose Example 

Addition + Summation of Numbers X=5+6 will yield 11 

Subtraction - Subtraction of Numbers X=9-5 will yield 4 

Multiplication * Product of Numbers X=3*4 will yield 12 

Division / Division of Numbers X=9/3 will yield 3.0 

Modulus % Return remainder X=5%2 will yield 1  

Floor Division // Divides and truncates the 

fractional part from result  

X=7//2 will yield 

3.0 

Exponentiation  ** Return base raised to power 

exponent 

X=3**3 will yield 

27 

 

 Relational Operator: Relational operators are used to describe relationship 

between values or operands. In python, you will use six relational operators for 

comparing values. These operators are also known as comparison operators.  

The six relational operators are: 

Operator Example 

if a=9, b=5 

Result 

>      Greater than a>b True 

<      Less than a<b False 

>=    Greater than or equal to a>=b True 

<=    Less than or equal to a<=b False 

==    Equal to a==b False 

!=    Not equal to a!=b True 
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You can conclude that resultant of comparison operator will be either True or 

False. 

 

2.4  SEQUENCE BASED PROGRAMMING 
 

You have already been learnt about simple programming in Python in class VII. Here, 

it is once again is discussed for revision and more clarity. As we know that 

programming is the execution of some commands in an order. This is termed as 

sequential programming. Let us understand and revise it with a simple example.  

 

Suppose, we have to make a program in Python in which we have to accept the “Age” 

of a person from the user and display its age on the screen after 5 years. Let us 

write the code for the same in python as given below: 

 
 Now, you may observe the commands in python for the above said program. Also, we 

will see its output at run-time which is given below:- 

 
As you may observe that above three (03) commands are executed in the order in 

which they are written and one cannot change the order of execution. So, this is 

understood as Sequence based programming. 

 

There are a few examples given for more practice at the end of this unit. 

 

2.5  ‘if..else’ STATEMENT 

 
In python, if…else statement is used to test/check one or more condition(s) and then 

execute some commands. The if…else statement evaluates test expression and will 

execute the body of if only when the test condition is True. If the condition is False, 

the  body of else is executed. Statements that are written at the same indent form a 

block.  

 

The SYNTAX of if..else statement is: 

 if <condition>: 

  Statement 1 

  Statement 2 

  … 

  … 
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  Statement N 

 else: 

  Statement 1 

  Statement 2 

  … 

  … 

  Statement N 

 

Let us understand it with an example.   

 

Program to check whether inputted number is smaller than 100 or not. You will write 

the following code in python. 

 

Code: 

 
 

You can observe, we have applied a condition  NUM>1000. If the entered number is 

greater than 100 then we will get a message “NUM is > than 100” otherwise we will get 

a message positive “NUM is <= than 100”. 

 

Now, let us observe the output of the above code for one number which is > 100 and 

one which is not > 100. 

 

  
 

We can also write a single statement or multiple statements in any part of the decision 

statement. 

  

There are a few examples given for more practice at the end of this unit. 
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3. LOGICAL OPERATORS IN PYTHON 

 
3.1 INTRODUCTION TO LOGICAL OPERATORS 

3.2 TYPES OF LOGICAL OPERATORS 

NOT, AND, OR 

3.3 RANGE FUNCTION 

3.1 INTODUCTION TO LOGICAL OPERATORS 
 

Dear students, today we shall discuss something about the logical operators in python 

and its applications in solving a variety of real world applications. We can program 

mainly those applications that involve the reverse of a given statement/condition or 

which involves two or more than two conditions. Some of the examples of such 

applications are: 

(a) We have to print the age of Rama if he is not studying in class 8th. This example 

involves the reverse or negation of a statement/condition. 

(b) Or we have to print the age of Rama only if he is studying in class 8th and 

his/her age is more than 13 years and many more like this.  

(c) Or we have to print the age of Rama if he is studying in class 8th or his/her age 

is more than 13 years and many more like this. 

Let us now discuss how we can program such applications using the logical operators. 

 

3.2 TYPES OF LOGICAL OPERATORS IN PYTHON 
Python supports three (03) types of logical operators as are used in almost all the 

available programming languages. These are: 

1. NOT 

2. AND 

3. OR 

 ‘not’ operator: “not” operator functions on a single (01) 

operand/condition/expression. It reverses the current status(either True or 

False) of a statement i.e. if the value of the whole statement/expression is True 

then it will give an answer False and vice-versa. It can be used in python by the 

keyword “not”. 

It can also be understood by the given example: 
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E.g. suppose statement A is “Meera is a good girl.”, then if we say NOT A, it will be 

read as “Meera is not a good girl.” 

It can also be understood by the following table: 

A not A 

0 1 

1 0 

Here, if the value of A is 0 i.e. False, then NOT A will be 1 i.e. True and if the value of 

A is 1 i.e. True, then NOT A will be 0 i.e. False. 

Now, let us take one more example of NOT operator in python. Just see and try to 

understand its functioning: 

 

The example has a variable named Age whose value is initially assigned 14. Now, the ‘if’ 

condition is checking whether the value of the Age variable is not greater than 18, then 

a message “Age is less than or equal to 18” will be displayed on the output screen. 

Otherwise, a message “Age is greater than 18” will get displayed if the above condition 

is False. 

 AND Operator: “AND” operators work on two(02) or more than 02 

conditions/expressions and it will give the result True only when both the 

conditions are True. It will give the result False, if any one of the two(02) 

conditions is False. In python, this operator is used by symbol “&” or keyword 

“and”.  

It can also be understood by the following table: 

A B A AND B 

0 0 0 

1 0 0 

0 1 0 

1 1 1 

Here, the value of the final expression will be 1 or True only when the value of both 

the conditions A & B are 1 or True. 
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This can easily be understood by the following example: 

Let us say we need to make a program in python to check the age of a student between 

13 and 15 and if both these conditions are True, then the value of a CLASS variable will 

be 8, otherwise a message should be displayed “CLASS NOT KNOWN”. This can well be 

understood by the following code in python: 

 

 OR Operator: “OR” operators work on two(02) or more than 02 

conditions/expressions and it will give the result True if any one of the two 

conditions is True. It will give the result False, if both the two(02) conditions 

are False. In python, this operator is used by the keyword “or”.  

It can also be understood by the following table: 

A B A OR B 

0 0 0 

1 0 1 

0 1 1 

1 1 1 

Here, the value of the final expression will be 1 or True if the value of any one of the 

conditions A & B is 1 or True. 

This can easily be understood by the following example: 

Let us say we need to make a program in python to check the age of a student whether 

it is greater than 13 or is smaller than 15 and the value of a CLASS variable will be 8 if 

any one of the two conditions is 1 or True, otherwise a message should be displayed 

“CLASS NOT KNOWN”. This can well be understood by the following code in python: 
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3.3 USE OF “RANGE()” FUNCTION 

  
Python supports a variety of functions which make it very rich in doing the complex 

things very easily. One  such function is “range()”.  

“range()” function is used to generate a sequence of set of values starting from a 

particular number called lower limit to another number called upper limit. A sequence is 

the occurrence of values in a linear order. It works on integer or numeric values only.  

Let us now see how the range() function works. Its syntax is: 

   range(<lower-limit>, <upper-limit>) 

range(1,n) function will generate a sequence of values from 1 to n-1 with an increasing 

value(called Step-value) of 1 by default. 

Some few examples are: 

Statement Sequence of values 

generated 

Step Value or Increasing Value 

range(0, 5) [0,1,2,3,4] 1 

range(10,17) [10,11,12,13,14,15,16] 1 

range(4,9) [4,5,6,7,8] 1 

range(8,0) Blank [ ] 1, as lower-limit is greater than upper-

limit 

APPLICATION OF “RANGE()” FUNCTION WITH SKIP VALUES 

 
As we have discussed above, “range()” function is used to generate a sequence of 

values starting from a particular number called lower limit to another number called 

upper limit with a DEFAULT SKIP VALUE of 1. Here, Skip value means the next value 

which comes after one value, then 2nd value, and so on. 

 

But in this article, we shall discuss that this default skip value may be changed and 

therefore, its output result. We may pass a Skip value in the range() function that will 

skip that much value in the previous value and generate a new value till the upper-limit.  

In the statement range(1,n,2), one will get a sequence of values (1, 3, 5, … up to n - 1). 

 

 

 

Copyright Number:- L-100563/2021 Registered With:- KVS Delhi Region



P a g e  | 35                                                   KVS DELHI REGION 2021 
 

We can better understand this by using the following example:- 

Statement Sequence of values generated Step/Skip Value 

range(0, 5, 2) [0,2,4] 2 

range(10,17, 3) [10,13,16] 3 

range(4,9, 2) [4,6,8] 2 

range(8,0, -1) [8,7,6,5,4,3,2,1] -1 

range(8,0, -2) [8,6,4,2] -2 

range(8,0, -3) [8,5,2] -3 

 

The main application of the range() function will come along with ‘for’ loop which will be 

discussed in the next article with plenty of examples. 
 

EXERCISE 3.2 

 

A. Answer the following questions. 

1. Write the use of range() function with the help of an example. 

________________________________________________________________ 

2. What do you mean by lower-limit and upper-limit in a range() function? 

________________________________________________________________ 

3. What is a skip value in range() function? Write one example of it. 

________________________________________________________________ 

4. Can range() function print the following output? If yes, then write its command using 

range() function. 

10 9 8 7 6 5 4 3 2 1 

 ________________________________________________________________ 

 

B. Fill in the Blanks 

1. In the statement range(1, 10, 3), 3 is a ________ value. 

2. In the statement range(1, 10, 3), 10 is  ________ value. 

3. In the statement range(1, 10, 3), 1 is  ________ value. 

4. The output of the statement range(1, 10, 3) is __________. 
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4. PYTHON 
4.1 CONCEPT OF LOOP/ITERATION: "FOR"  

4.2 PRACTICE PROBLEMS ON "FOR" LOOPS 

4.1 CONCEPT OF LOOP: ‘FOR’ LOOP 

 
In the real world, there are numerous situations in which one has to do some work 

repeatedly up to a specific number of times. For example, if a student wants to print 

natural numbers up to 10 or to print his/her name 100 times or to print a Maths table 

of a given number up to N. 

 

But, to get the solution of the above questions in python, we need to understand the 

concept of a Loop. 

 

Loop: A loop can be defined as a cycle of execution of various statements again & again 

up to a specific number of times. Let us take an example to comprehend the concept of 

loop. 

 

Example: To print the natural numbers up to 10, one must have the following 

commands: 

(a) First take a variable named COUNT and assign it a value 1, 

(b) Then, print COUNT, 

(c) Increase the value of COUNT by 1, 

(d) Now, check the value of COUNT whether it is less than or equal to 10. If 

it is less than or equal to 10, then execute the steps (b), (c) and (d) again till the 

value of COUNT reaches 10. 

To understand the above program more clearly, we can draw its flow chart which is 

given below: 

 

 

 

 

 

 LOOP 
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Now, to execute the above program in Python language, we have to learn the ‘for’ loop. 

Let us discuss it. 

 

 ‘for’ loop: ‘for’ loop is a type of looping statement which is used to execute 

some commands again and again up to a specific number of times. Its syntax in 

python is given below: 

  for <loop-variable> in range(<lower-limit>,<upper-limit>): 

    Statement – 1 

    Statement – 2 

    .    Body of the ‘for’ loop 

    . 

    Statement – N 

Let us discuss the elements of ‘for’ loop in details: 

 ‘for’ is a keyword and used for ‘for’ loop, 

 Loop-variable is the name of the variable which is used to run the loop and 

whose value will increase automatically by 1, 

 ‘in’ is a reserved keyword used to check the value of loop-variable in the 

sequence of the values generated by range() function, 

 range() function is discussed above in the previous article. 

 Statement -1, 2, …., N are the statements/commands which are to be executed 

in the loop again and again. 

Now, let us make the program we have discussed above i.e. to print the natural numbers 

up to 10 using ‘for’ loop: 

 
In the above example, we have taken COUNT as the loop-variable and assign it  a value 

10 as lower-limit in the range() function. Also, we have assigned the value upper-limit as 

11 which is 1 more than 10 up to which we have to print the natural numbers. 
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4.2 PRACTICE PROBLEMS ON ‘FOR’ LOOP 

 
In this article, we will discuss and do some problems on ‘for’ loop for more clarity and 

understanding of it. Students should practise the same in python. 
Q1.  Write a program in python to display the following series in separate lines 

using ‘for’ loop: 

  4 5 6 7 8 9 10 11 12 

Ans. 

 
Q2.  Write a program in python to display the following series in separate lines 

using ‘for’ loop: 

  1 4 7 10 13 16 19 

Ans. 

 
Q3. Write a program in python to accept any two numbers from the user and 

display the numbers that exist between them excluding them. E.g. if a 

user enters A=5 and B=11, then the output should be 6, 7, 8, 9, 10. 

 

 
Q4. Write a program in python to accept a number from the user and display 

the squares of natural numbers up to it. E.g. if the user enters N=5, then 

output should be:    1 4 9 16 25 

Ans. 

 
Q5. Write a program in python to accept a number from the user and display 

its complete table. E.g. if the user enters N=5, then output should be: 

5 10 15 20 25 30 35 40 45 50 

Ans. 

 
Q6. Write a program in python to accept a number from the user and display 

the following output. E.g. if the user enters N=5, then output should be: 

---->> ---->> ---->> ---->> ---->> 

Ans. 
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SOME PROGRAMS ON ‘FOR’ LOOP TO DO 

1. WAP in python to accept a number from the user and print your name up that many 

number of times. 

2. WAP in python to accept a number from the user and display the cube of every 

number up to it. 

3. WAP in python to accept any two numbers (a & b) from the user and display the 

numbers existing between them excluding (a & b). 

4. WAP in python to accept a number from the user and display that number up to that 

many number of times. E.g. if the user enters N=5, then output should be 5 5 5 5 5. 

5. WAP in python to display the following output: 2 5 8 11 14 17 20 23  

Copyright Number:- L-100563/2021 Registered With:- KVS Delhi Region



P a g e  | 43                                                   KVS DELHI REGION 2021 
 

 5. ADVANCED GIMP 
 

  5.1 REVIEW OF CLASS VII 

   5.2 DIGITAL B&W CONVERSION 

5.3 TONE MAPPING WITH ‘COLOURS/EXPOSURE’ 

5.4 CHANGING BACKGROUND COLOUR 

  5.5 RED EYE REMOVAL 

    5.6 SEPIA TONING 
  

 

 

 

5.1 REVIEW OF CLASS VII 
There are many photo editing software like Photoshop, Microsoft Paint and Drawing of 

Open Office.org etc. In this chapter, we are going to study GIMP (GNU Image 

Manipulation Program) software.  

GIMP is a Free and Open-Source Image Editor software. It is used for image editing 

and manipulation. 

 

 

GIMP is a multi-platform photo manipulation tool. Most GNU/Linux distributions 

include GIMP as a standard application. The GIMP is also available for other operating 

systems such as Microsoft Windows™ or Apple’s Mac OS X™ (Darwin).  

The GIMP is a Free Software application covered by the General Public License [GPL]. 

The GPL provides users with the freedom to access and alter the source code.  
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GIMP FEATURES ARE:  
 It is Open and Free software. 

 It supports different file formats such as gif, jpeg, tiff etc. 

 It works with different operating systems such as Linux, Mac OS and Microsoft 

Windows. 

 It is used for image manipulation (retouching) and image editing. 

 GIMP provides different tools for image editing. 

 GIMP paintbrush tool is used to draw images easily. 

 It is a memory efficient graphic tool. 

 Combining different images in GIMP to create animation. 

 There are several ways of creating colors in GIMP. 

HOW TO DOWNLOAD GIMP  

Following are the steps to download GIMP:- 

 Search website www.gimp.org 

  Click on Download. 

 Click “Download Gimp” 
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After the completion of downloading, Install GIMP on computer. 

 

GIMP FILE FORMATS 

Formats Expansions 

PSD Photoshop  

PCS Personal Computer Exchange 

XPM X Pixmap 

JPEG Joint Photographic Experts Group 

PPM Portable Pixmap 

TIFF Tagged Image File Format 

GIF Graphics Interchange Format 

BMP Bitmap 

XWD X Window System 

PNG Portable Network Graphics 

GIMP Compatible Platforms:  

❖ GNU/Linux (i386, PPC)  

❖ Microsoft Windows (XP, Vista, Windows 7)  

❖ Mac OS X  

❖ Sun Open Solaris  

❖ FreeBSD 
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5.2 DIGITAL B&W CONVERSION 
Following are the steps to 

convert black and white image 

into colour image. 

Step 1: Open image 

Step 2: Click on colours menu-> 

Desaturate-> Click on 

Desaturate. 

There are other options also to 

convert coloured image into 

black and white. But this is the 

easiest method. Desaturate 

command converts all the colours of active layer into shades of greys. 

 

5.3 TONE MAPPING WITH ‘COLOURS/EXPOSURE’ 

Tone mapping is a technique used in image processing and computer graphics. It is used 

to map one set of colours into another in order to approximate the high-dynamic range 

images in a medium of more limited dynamic range. 

Following are the steps to use Tone Mapping in GIMP:- 

Step 1: Click on File->click Open -> Select image. 

 

Step 2: Click on Colors->click on Tone Mapping. 

 

There are different image high dynamic ranges available.  
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5.4 CHANGING BACKGROUND COLOUR 
How to change the background colour of your image in GIMP? Following are the steps 

to change background colours: 

Step 1: Click on File->click Open -> Select image. 
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Step2: Click Fuzzy select or Select by colour tool from the Tools panel on the left and 

select the background colour to select it. 

Step 3: Click on Edit > Clear.  

 
Step 4: Now you can see image with a transparent background, If you want to add a 

solid colour, select the Bucket Fill tool and select the colour from colour palette. Then 

click on the background of the image to fill it with the new colour. 
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Step 5: Go to File Menu ->Click Export AS and save your image in .png format.  

5.5 RED EYE REMOVAL 
In Photography red-eye is a very common appearance in coloured photographs of the 

eyes of both humans and animals. This is due to the flash that is very close to the 

camera lens in low light. 

So how can you remove the red-eye in GIMP ? Following are the steps:- 

Step 1: Open your image. 

Step 2: Zoom your image by hitting the “+” key, until just the eyes fill the screen. 

 

 

Step 3:  Click on the Ellipse Select Tool in the Toolbox and select “Feather edges” 

giving them a radius of around 15-20. And draw an ellipse around one eye that 

encompasses the redness to be removed.  
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Step 4: Select Menu Filters-> Enhance->click on Red Eye Removal option. 

 

 

Step 5: Save your image. 

5.6 SEPIA TONING 

It is the most popular tool used in image editing. Sepia effect gives your images a warm 

brownish tone. Sepia filter improves the general look and feel of your image. 
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Following are the steps to give ‘Sepia effect’  in GIMP. 

Step 1 : Open your image. 

 

 
 

Step 2: Click the Colors menu -> Desaturate.  In the next screen, choose Luminosity 

and click OK. 

 

Step 3: Click Colors -> Brightness-Contrast->Set the Brightness to +30. 
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Step 4: Click on image->Duplicate and create duplicate of your layer. 

 

Step 5: Select the foreground colour. Click on Layer Menu-> click ‘New Layer’ and  fill 

with foreground colour.  

 
Step 6: In the Layers Palette, click the top Mode: drop down and select Overlay.  
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Exercise 

Something To Know:- 
A. Multiple Choice Questions: 

 

1. _________ tool helps you to add a new layer to the image which is identical 

copy of the active layer. 

a. Duplicate Layer 

b. Delete Layer 

c. Merge Layer 

d. None of these 

 

2. What is the shortcut key combination in GIMP to rotate an image? 

 

a. Shift+T 

b. Shift+R 

c. Shift+F 

d. Shift+C 

 

3.  Which of the following is GIMP’s native format ? 

a. xcf 

b. tiff 

c. png 

d. jpeg 

 

4. The image loses some of its quality by being _________  

a. Merged   

b. Renamed 
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c. Layered 

d. Scaled 

 

5. GPL refers to…. 

a. General Private license  

b. Great Public  License  

c. General Public Limited  

d. General Public License 

 

B.  State True(T) / False(F) 

1. The Flip tool is used to rotate the image in the other direction to create the 

image.  

2. The Smudge tool uses the current brush to smudge colors on the active layer or 

a selection.  

3. An image cannot be rotated in GIMP.  

4. Layers are the transparent sheets one on top of the other.  

5. An image can be flipped only horizontally not vertically.  

 

C. Answer the following questions: 

1. Mention some features of GIMP. 

2. Which tool is used to align the objects placed on different layers? 

3. Write down the steps for Tone Mapping in GIMP? 

4. What is the function of smudge tool? 

5. Identify the tools used for following purpose. 

(i) To create the mirror image 

(ii) To align the layers with different objects 

(iii) To resize the layer/image 

SOMETHING TO DO: 
Here are some ideas 

❖ Take any image and change its background color 

❖ Take any image with red eye and remove red eye effect.  

❖ Take any image of Vidyalaya activity and convert it into B& W. 
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6. Information Technology 

 
6.1  E-Learning 
6.2  E-Governance 

6.3 E-Commerce                                                                                                                

6.4  Social Networking 

 

 

 

 
Introduction  

Information technologies have brought a fundamental change in the society, 

driving it forward from the industrial age to the networked era. In our world, 

global information networks are vital infrastructure, but in what ways has this 

changed human relations? The Internet changed education system, Government 

system, healthcare system, and even the ways in which we interact with our 

loved ones—it has become one of the key drivers of social evolution. 

6.1 E-Learning  

 

 

 

 

 

 

 

 

 

 

Fig. 6.1: E-Learning 

 E-learning referred to as online learning or 

electronic learning, is the acquisition of 

knowledge which takes place through electronic 

technologies and media.  

E-learning provides online resources for studying. 

E-learning can be done 24*7. 
Fig 6.2 (a) E- learning process 
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Video lecture can be recorded and used later. Online classes can be conducted by using 

various online tools  e.g. Google Meet, Microsoft Team  etc. 

 

6.2 E-Governance 

 
 

Fig. 6.3: E-Governance 

 
E-governance is understood as the use of Information and Communication 

Technology (ICT) at all the levels of the Government in order to provide services to 

the citizens, interaction with various enterprises and exchange of information between 

different parts of the Government in a speedy, convenient, efficient and transparent 

manner. 

 

e-governance is implemented by countries across the world. For efficient 

development of a country e-governance is needed. 

 

Through e-governance, government services are provided to citizens and 

businesses in a convenient, efficient and transparent manner. E-Governance services 

like Digital India initiative, National Portal of India, Prime Minister of India portal, 

Aadhar, filing and payment of taxes online, digital land management systems, Common 

Entrance Test etc. 

 

Four major types of interactions of E-Governance: 
1. Government to Government (G2G) means information is exchanged within the 

government. 
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2. Government to Citizen (G2C) means the citizens have a platform through which 

they can interact with the government and get access to the variety of public 

services offered by the Government. 

3. Government to Businesses (G2B) means businesses are able to interact with the 

government seamlessly with respect to the services of the government offered 

to businesses. 

4. Government to Employees (G2E) means interaction between the government and 

its employees occurs in an efficient and speedy manner. 

 
The following are some e-governance initiatives:  

● Digital India was launched in 2015 to empower the country digitally.  Its main 

components are: 

○ Developing a secure and stable digital infrastructure 

○ Delivering government services digitally 

○ Achieving universal digital literacy 

● Aadhar is a unique identification number issued by UIDAI that serves as a proof 

of identity and address on the basis of biometric data. It is used to provide 

many  free services to the society. One can e-sign documents using Aadhar.  

● mygov.in is a national citizen engagement platform where people can share ideas 

and be involved with matters of policy and governance.  

● UMANG stands for  Unified Mobile Application which provides access to central 

and state government services including Aadhar, Digital Locker, PAN, Employee 

Provident Fund services etc.  

● Digital Locker is used to store digitally important documents like mark sheets, 

PAN, Aadhar, and degree certificates etc. 

● Computerization of Land Records ensures that landowners get digital and 

updated copies of documents relating to their property.   

In addition to this, State level e-governance initiatives include: 

● E-Seva (Andhra Pradesh) facilitates payment of utility bills, issuance of 

certificates, licenses and permits.  

● Khajane Project (Karnataka) digitalized the treasury system of the state. 

● Lokvani Project in UP is a single-window solution for various services for the 

peoples like Land records,  Grievances etc. 
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E-Governance portal 

The Indian e-governance portal is https://nceg.gov.in . On this portal, one can get 

comprehensive information regarding the National Conference on E-governance and 

reports on earlier conferences.  

In addition to above, the portal provides links to the following important pages: 

● Digital India 

● National Portal of India: This portal provides the various Government services 

● PM India Website: It provides information relating to the Prime Minister’s 

Office.  

● United Nations e-governance website. 

6.3 E-Commerce 

 E-commerce (Electronic commerce) is used to buy and sell goods and 

transmitting of funds over the Internet. These business transactions occur as 

business-to-business (B2B), business-to-consumer (B2C), consumer-to-consumer or 

consumer-to-business. The term electronic-tail is also sometimes used in reference to 

the transactional processes that make up online retail shopping. 

 

 
 

Fig. 6.4: E-Commerce 

 
Top E-commerce websites are Amazon, Flipkart, Snapdeal, Jabong, Shopclues etc. 
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Advantages of e-commerce : 
 

Benefits of e-commerce include its round-the-clock availability, the speed of 

access, the wide availability of goods and services for the consumer, easy accessibility 

and international reach. 
 

1. Availability : Besides outages or scheduled maintenance, e-commerce sites 

are available 24x7, allowing visitors to browse and shop at any time.  

2. Speed of access : While shoppers in a physical store can be slowed by 

crowds, e-commerce sites run quickly, which is determined by computer and 

bandwidth considerations on both consumer devices and e-commerce sites. An e-

commerce transaction takes only a few clicks and sometimes less than five 

minutes. 

3. Lower cost :  Pure play e-commerce businesses avoid the cost associated 

with physical stores, such as rent, inventory and cashiers, although they may 

incur shipping and warehouse costs. 

4. Personalization and product recommendations: E-commerce sites can 

track visitors' browse, search and purchase history. They use this data to 

present useful and personalized product recommendations and obtain valuable 

insights about target markets. Examples include the sections of Amazon product 

pages labelled "Frequently bought together" and "Customers who viewed this 

item also viewed." 

 

Disadvantages of e-commerce 

1. Limited customer service : If a customer has a question or issue in a 

physical store, he or she can see a clerk, cashier or store manager for help. 

2. Not being able to touch or see : While images on a webpage can provide 

a good sense about a product, it's different from experiencing it "directly," such 

as sound of a speakers,  picture quality of a T.V or trying on a dress. 

3. Wait time :  If a customer sees an item that he or she likes in a store, the 

customer pays for it and then goes home with it. There may be delay in the 

product to be shipped to the customer's address. 

4. Security :  Skilled hackers can create authentic-looking websites that claim 

to sell well-known products store. 

6.4 Social Networking 
Social networking means like-minded individuals to be in touch with each other 

using websites and web-based applications. Facebook, Twitter, Instagram and LinkedIn 

are examples of social networking sites. 
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Fig. 6.5: Social networking 
If you are involving in social networking, it means you're using social media sites, also 

known as social networks, to connect to others. Most popular social Networking 

websites are Facebook, Twitter, Instagram, Snapchat, LinkedIn, and Pinterest. 

 

Facebook Social network sited is one of good social network site in which you 

may know some other people who use the site and add them as friends. As you use more 

social platforms, it increases your network for sharing your ideas or views. 

 

 

 

 

 
Fig. 6.6: Social networking websites 
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Advantages and Disadvantages of Social Networking 
 

There are positives and negative aspects of latest form of social networking. 

You can use social websites like Facebook to launch a new business, sell your products 

or services, and extend the reach of your brand. These platforms can also become an 

inescapable place where peer pressure can push people towards choices they would 

never make without its influence. 

 

Advantages of social Networking 
 

1. Networking without border 
 

No boundary of the social media. Social networking sites are enabling everyone 

to connect no matter which country they belong to. 
 

2. Instant News and Information 
 

On Social networking, communication may be one-to-many instantly. The news will 

be available on modern social networking sites like Facebook, Twitter. 
 

3. Great marketing channel for Business 
 

Social networking sites provide good marketing channels for doing the business. 

The various Artificial techniques are used on social networking sites  platforms for 

Marketing. 
 

4. Awareness and Activism 
Social Networking sites aware us about events around the world. Social 

networking sites play a very important role in such revolutions and events. 
 

5. Exchange of ideas and Collaboration 
Social networking site like Facebook has collaboration features like Group and 

Document sharing. Social networking sites are very useful to collect feedback and 

comments on various ideas. 

 

Disadvantages of Social Networking 
 

1. Addiction 
The irresistible behavior developed due to social networking sites like Facebook, 

Instagram, YouTube, etc. leads to negative effects. Social networking addicts 

constantly check out people’s profiles for hours and hours. 
 

2. Mental Illness 
 

Social networking sites are increasing risk of mental health problems like 

depression, anxiety, and loneliness. Spending so much time by scrolling through social 

media can result in symptoms of anxiety and/or depression. Teenagers’ mental health is 

often negatively affected by this culture of comparison as well. 
 

Copyright Number:- L-100563/2021 Registered With:- KVS Delhi Region



P a g e  | 62                                                   KVS DELHI REGION 2021 
 

3. Frauds and Scams 
It is one of the challenges for social media companies. There are No. of fake 

users accounts on various social networking sites including Facebook, Instagram, and 

Twitter. 
  

4. Misleading Information 
It is the most challenging problem for social media companies. Fake Information 

and misleading News can go viral in few seconds on social media platforms.  
 

5. Privacy Issues 
Your activities on social media can help people or companies know who you are or 

what you are searching etc. By your sharing image history or your profile privacy issues 

may also come. 

 
 

Exercise 

Something to know 
A. Answer the following questions. 

1. What is E-learning? Give an example of E-Learning. 

2. What is E-Governance? Give an example of service provided by E-Governance. 

3. What is E-Commerce? Write names of two E-commerce sites. 

4. What is Social Networking? Give some examples of social networking sites. 

5. Write some advantages of E-Learning. 

 

B. Fill in the blanks: 

1. _______________is the fastest and easiest way of learning in the present 

mode of education. 

2. ________________in India has steadily evolved from computerization of 

Government Departments. 

3. __________is the buying and selling of goods and services, or the transmitting 

of funds or data, over an electronic network, primarily the internet. 

4. Social networking services can help young people develop their___________. 

5. https://epathshala.nic.in/ (NCERT) is an example of _____________ website. 

 

C. Match the Following: 

1. E-Learning website a) www.facebook.com 

2. E-Commerce website b) www.cybercrime.gov.in 

3. E-Governance website c) www.diksha.gov.in 

4. Social Networking website  d) www.flipkart.com 
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D. Select the correct answer for each question : 

1. E-learning provides all the following benefits EXCEPT: 

(a) bringing the training to students. 

(b) replacing conventional learning experiences. 

(c) facilitating just-in-time skill development. 

(d) being more cost effective. 

 

2. The facilitator for National e-Governance Programme (NeGP) in India is: 

      (a) Department of Electronics and Information Technology 

      (b) Education Ministry 

      (c) Department of E-Governance 

      (d) Department of Defense. 

            

           3. Which of the following describes E-commerce? 

(a) Doing Business 

(b) Doing Business Electronically  

(c)       Sale of Goods 

(d) All of the above 

 

          4.  Which Social networks are organized primarily __________. 

(a)  Brands 

(b)  people 

(c)        discussion 

(d)  Interests 

 

D. State True or False  

1. Online evaluation of answer sheets is possible. 

2. Online fraud does not happen in online shopping.   

3. E-Governance sites provide direct services to people. 

4. Social networking may give false information also. 

SOMETHING TO DO 

1. Go and explore the following sites : 

https://epathshala.nic.in/ 

https://diksha.gov.in/ 

2. Participate in any quiz on E-Governance site :   https://www.mygov.in/ 
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APPENDIX 

ANSWERS OF EXERCISE 

EXERCISE1.1 
A. Answer the following questions. 

1. What do you mean by a database? 

           Ans. A database is a storage area to save a huge amount of interrelated data. 

2. What is a DBMS and why is it required? 

           Ans. A Database Management System is a software used to create, edit and 

delete data from a database. It is required to maintain the database in such a manner  

that it will always give accurate information. 

      3. What is a table in a database? 

           A table is the intersection of rows and columns and it is used to store the data. 

4. Give the name of any 1 real world example in which you have learnt about 

databases. 

Bank, School, University, etc.(any one) 

5. What is a primary key? 

     A primary key is a column of a table which has unique values and it is used to 

identify every record differently. 

 

B. Fill in the blanks:- 

1. Database 2. Database Management System 3. Table 4. Varchar 5. 

Primary key 

 

C. State True / False:- 

      1. False   2. False 3. False 4. True  5. False 

EXERCISE 1.2 
 

A. Answer the following questions. 

       1. What do you mean by wizard? 

       Ans. A wizard is a step-by-step guide help of the procedure of creation of a 

database object like a table, query, etc. 

       2. What is the importance of a wizard? 
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       Ans. A wizard helps the user to understand the procedure of how to successfully 

create a table or a query. 

       3. Can we assign a primary key to a field during the creation of a table using 

wizard? 

       Ans. Yes. 

4. What do you mean by a query?  

Ans. A query is a request for some information from the database. 

5. What is the use of query in a database?  

       Ans. A query is used to find some specific information which is required instead of 

data from the whole table. 

B. Fill in the blanks 

1. Wizard 2. Query 3. Sort  4. Field  5. Alias 

C. State True / False:- 

1. True  2. False 3. True  4. True  5. False 

********** 

Chapter 2.1 

A. Answer the following questions:- 

1. What do you mean by a keyword? 

A keyword is a pre-defined reserved word in a programming language which has 

fixed function and cannot be changed. E.g. if, else, etc. 

      2. What is a variable? Why is it needed in a program? 

A variable is an identifier which is used to store some value temporarily for the 

program time. It is needed in a program to store and access some values during 

the program execution.  

     3. Write the use of a flowchart. 

A flowchart is used to represent the execution steps of a program pictorially 

and diagrammatically so that it is easy to understand the execution flow of the 

program. 

4. What is a data type and what is its importance in programming? 

A data type is used to tell what kind of data will be used in a variable like 

integer, float, string, etc. 

5. What is the meaning of sequential programming? 

     Sequential programming is defined as making such programs that  
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     involve the execution of commands in a specific sequence one by one    

     i.e. one after the previous one and so on. 

B. Fill in the blanks:- 

1. Keyword  2. Relational  3. Algorithm  4. Arithmetical 

5. Flowchart 

C. Match the following:- 

1. (b)  2. (c)  3. (a)  4. (e)  5. (d) 

D. Predict/Select the correct OUTPUT for each question:- 

1. (C)  2. (A)  3. (B)  4. (B)  5. (B) 

E. State True/False:- 

1. True  2. False 3. True  4. False 5. False 

Chapter 3.1 

A. Answer the following questions:- 

1. What do you mean by the logic of a problem or a program? 

Ans. Logic of a program is the method or solution of the problem or a program by which 

it can be solved. 

2. What is a logical operator? 

Ans. A logical operator is a type of operator in python which is used to check one or 

more conditions for their Trueness or Fallacy. Types of logical operators in python are 

not, and & or. 

3. Write the function of ‘not’ logical operator in python. 

Ans. ‘not’ is a unary logical operator that works on a single condition and gives the 

reverse of the value i.e. it gives True when result comes False and vice-versa. 

4. What is the difference between ‘and’ & ‘or’ logical operator? 

Ans. ‘and’ logical operator is used to give the final result ‘True’ only when both the 

conditions are True but ‘or’ operator is used to give final result ‘true’ if any one of the 

two conditions is True. 

B. Fill in the blanks:- 

1. not  2. Logical  3. Relational  4. ‘or’  5. Two(02) 

C. Predict/Select the correct OUTPUT for each question:- 
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1. (A)  2. (A)  3. (A)  4. (A)  5. (A) 

D. State True / False:- 

1. False 2. False 3. True 4. False 5. False 

 

Chapter 3.2 

A. Answer the following questions:- 

1. Write the use of range() function with the help of an example. 

Ans. ‘range()’ is a function that is used to generate a sequence of values from a lower-

limit to one less than upper-limit number. It only works on integers. E.g. range(1,5) will 

give (1, 2, 3, 4) output. 

2. What do you mean by lower-limit and upper-limit in a range() function?  

Ans. Lower-limit is the value from which a range() function starts generating numbers. 

Upper-limit is one less than the value up to which a range() function will generate the 

numbers. E.g. in range(1,5), lower-limit is 1 and upper-limit is 5. 

3. What is a skip value in range() function? Write one example of it.  

Ans. Skip value is the step or increment value which is to be added in the previous value 

to generate the next value.  

E.g. In range(1, 10, 2) statement, 2 is the skip value which will be added to every 

previous value and give the following result (1, 3, 5, 7, 9). 

4. Can range() function print the following output? If yes, then write its command using 

range() function. 10 9 8 7 6 5 4 3 2 1  

Ans. Yes. range(10, 0, -1). 

B. Fill in the blanks:- 

1. Skip Value  2. Upper-limit value. 3. Lower-limit value. 4. 1 4 7. 

C. Predict/Select the correct OUTPUT for each question:- 

1. (A)  2. (B)  3.  (C)  4. (A)  5. (A) 

 

D. State True / False:- 

1. True  2. True  3. False 4. False 5. False 
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Chapter 4.1 

A. Answer the following questions:- 

1. What is the meaning of a loop? 

Ans. A loop can be defined as a cycle of execution of some statements again and again 

up to a specific number of times. 

2. Why is a loop is used in programming? 

Ans. A loop is used in programming to solve those problems that involve execution of 

the same commands again and again up to a specific number of times. 

3. Which loop is used in python? 

Ans. ‘for’ loop is used in python programming language. 

 

B. Predict/Select the correct OUTPUT for each question:- 

1. (B)   2. (C)  3. (B)  4. (C)  5. (C) 

 

C. State True / False:- 

1. False 2. True  3. True  4. False 5. False 

 

CHAPTER 5 

A.  Multiple Choice Questions: 

 

1.  Duplicate Layer 

2. Shift+R 

3. xcf 

4. Scaled 

5. General Public License 

 

B.  State True(T) / False(F) 

1. The Flip tool is used to rotate the image in the other direction to create the 

image. True 

2. The Smudge tool uses the current brush to smudge colors on the active layer or 

a selection. True 

3. An image cannot be rotated in GIMP. False 

4. Layers are the transparent sheets one on top of the other. True 
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5. An image can be flipped only horizontally not vertically. False 

 

C. Answer the following questions: 

1. Mention some features of GIMP. 

Answer : 

 It is Open and Free software. 

 It supports different file formats such as gif, jpeg, tiff etc. 

 It works with different operating systems such as Linux, Mac OS and Microsoft 

Windows. 

 It is use for used for image manipulation (retouching) and image editing. 

 GIMP provides different tools for image editing. 

 GIMP paintbrush tool is use to draw images easily. 

 It is a memory efficient graphic tool. 

 Combining different images in GIMP to create animation. 

 There are several ways of creating colors in GIMP. 

 

2. Which tool is used to align the objects placed on different layers? 

Answer: Align tool 

 

 

3. Write down the steps for Tone Mapping in GIMP? 

Answer:  

Step 1: Click on File->click Open-> Select image. 

Step 2: Click on Colors->click on Tone Mapping. 

 

4. What is the function of smudge tool? 

Answer: The Smudge tool uses the current brush to smudge colours on the 

active layer or a selection. 

 

5. Identify the tools used for following purpose. 

(iv) To create the mirror image 

(v) To align the layers with different objects 

(vi) To resize the layer/image 
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Answer : (i) To create the mirror image : Flip Tool 

                 (ii) To align the layers with different objects : Align Tool   

                 (iii) To resize the layer/image : Scale Tool 

 

Chapter 6 

A: 

1. Ans.  E-Learning is learning utilizing electronic technologies to access 

educational curriculum outside a traditional classroom. In most cases, it refers 

to a course, program or degree delivered completely online. 

  

 e.g. https://epathshala.nic.in/  &     https://diksha.gov.in/ 

 

2. Ans.   

Electronic governance or e-governance can be defined as the usage of 

Information and Communication Technology (ICT) by the government to provide 

and facilitate government services, exchange of information, communication 

transactions and integration of various stand-alone systems and services. 

 

e.g. https://www.meity.gov.in/  & https://www.mygov.in/ 

 

3. E-commerce (electronic commerce) is the buying and selling of goods and 

services, or the transmitting of funds or data, over an electronic network, 

primarily the internet. These business transactions occur as business-to-

business (B2B), business-to-consumer (B2C), consumer-to-consumer or 

consumer-to-business. 

 

e.g. https://www.amazon.in/  & https://www.flipkart.com/  

 

4. Ans. Social networking is the use of Internet-based social media sites to stay 

connected with friends, family, colleagues, customers, or clients. Social 

networking can have a social purpose, a business purpose, or both, through sites 

such as Facebook, Twitter, LinkedIn, and Instagram, among others. 

 

https://www.instagram.com/ &  https://www.facebook.com/ 

 

5. Ans.  Advantages of E-Learning 

(i)  Online learning is self-paced 
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(ii) E-Learning is student-centered 

(iii) E-Learning is cost-effective 

(iv) E-Learning is environment friendly 

(v) In E-Learning there is no need for textbooks 

(vi Online learning is time-efficient 

 

B. Fill in the Blanks 

1. E-Learning 

2. E-Governance 

3. E-Commerce 

4. Interests 

5. E-Learning 

 

C. Match the Following. 

1 ---- c 

2 ---- d 

3 ---- b 

4 ---- a 

 

D. Select the correct answer for each question. 

1. B 

2. A 

3. B 

4. D 

 

E. State True  or  False  

1. True 

2. False 

3. True 

4. True 
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